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Remote Voice Tracking Overview

Remote Voice Tracking is an exciting new concept from P Squared that takes 
the basic ideas of Voice Tracking introduced in Myriad and expands the 
functionality to allow authorised users to review your Myriad Station Log, edit 
the Log and record Voice Tracks in to the log remotely, from the comfort of 
their own homes (or more likely from sister stations around the World).

Before we can start on the basics of Remote Voice Tracking (RVT) it is worth 
just quickly covering what we mean by Voice Tracking in the first place. Voice 
Tracking is a commonly used term to describe the practice of pre-recording 
specific voice links in to scheduled station output to be played automatically 
by your station’s playout system. In Myriad specifically, Voice Tracking is 
achieved using the Full Segue Editor mode on the Log screen. When Voice 
Tracking, Myriad will play back the last few seconds of the previous track and 
allow you to record you voice link over the top. You then control when the next 
track start and hence you can record a Voice Track in exactly the same way 
as you would do it live.

Remote Voice Tracking works in exactly the same way but with the exception 
of instead f sitting in the studio; you can Remotely Voice Track from any PC in 
the world with network connection to your radio station, a copy of the Remote 
Voice Tacking software and a microphone.

The diagram below shows a general overview of the way RVT works.
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When you use RVT to remotely edit the Station Log and record Voice Tracks, 
RVT will automatically download what is scheduled to play from the Remote 
Edit Server at your station, you can then decided where you want to record 
your first Voice Track. The system will then download a low quality version of 
the end of the previous track and then start of the next. You record your Voice 
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Track in the normal way before RVT uploads it back to your station ready to 
be played ‘on air’.

Throughout this manual, it is assumed that you are familiar with Myriad and 
the Voice Tracking facilities that it offers as well as having a good working 
knowledge of Internet technology and your station’s server infrastructure.

A Bit More Detail

Ok, now we have looked at the general overview it is time to look at the RVT 
system in a little more detail. 

Remove Voice Tracking by P Squared consists of two separate applications 
that work together to provide a high level of functionality whilst making the 
solution as simple to use and maintain as possible. The system consists of 
the Remote Edit Server which runs at your station and the actual Remote 
Voice Tracking Software which is installed at each remote site or roving 
machine you want to have access to your system.

The Remote Edit Server

The Remote Edit Server application acts as the gateway between your Myriad 
system and the Remote Voice Tracking software ensuring that the remote 
user never actually comes in to contact with your Myriad system.

The Remote Edit Server application needs to be installed on a PC that has 
Internet access as well as access to your Myriad network. This machine 
should be set up in such a way that it acts as a bridge between your Myriad 
network and the outside world and this is most commonly done by fitting two 
network cards to the PC and instructing the PC to act as the bridge between 
the two network cards (see Windows documentation for more details). 
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The Remote Edit Server is a fairly light application and in most cases, it is ok 
to run the application on your Myriad file server (or office server if it has 
access to the Myriad network) although this will depend on the load on the 
server and the specification of the machine.

So a typical set may consist of your normal Myriad network with a file server 
fitted with two network cards. One of the cards connects to the Myriad 
network whilst the other is plugged in to either your web enabled office 
network or possibly directly in your ADSL (or similar) router. The Remote Edit 
Server software application is then installed on this server and RVT clients 
connect to the Remote Edit Server via either a VPN or via a web connection.

The Remote Edit Server is also used to set up the options for all Remote 
Voice Tracking clients that connect to it. This way, you dictate what quality 
(and compression) of the recorded voice links that are submitted remotely and 
control the access that the remote user has.

The Remote Edit Server software is licensed by P Squared and you can only 
run one copy of the software per purchased license. Remote Edit Server will 
only support one connection at a time so you can not have more than one 
user Remote Voice Tracking at the same time.

The Remote Voice Tracking Software



9

The Remote Voice Tracking software is installed at all of the remote sites or 
roving PC’s that you want to be able to remotely Voice Track for your station. 
The Remote Voice Tracking software (or RVT) looks and acts just like Voice 
Tracking in Myriad with the exception that it downloads the audio information 
it needs from the Remote Edit Server as it needs it. This means that 
presenters that are familiar with Myriads Voice Tracking facilities will be 
instantly at home with RVT and all the facilities from the local version are 
carried over in the remote client.

Whilst the primary role of RVT is to allow you to record audio link remotely 
and then ‘upload’ them to the station, you can also use it to review and edit 
the Station Log remotely which makes it a useful tool for show preparation 
and administration.

Getting Started

The first thing you need to do is decide which PC is going to have the Remote 
Edit Server software installed. The reason the choice is important is that the 
PC must fulfil the following criteria in order to run Remote Edit Server 
effectively. 

1. The PC needs to have access to the Myriad network.
2. The PC needs to have access to the ‘real world’ via the web.
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3. The PC needs to be reasonably fast, it will be generating and 
compressing audio files as part of its job.

4. The PC needs to act as a bridge between the Myriad network and the 
real world without compromising the Myriad network (usually done with 
two network cards and bridge between them – see MS Windows 
documentation for more details).

If the PC you have in mind has all of these factors then it is a good candidate 
for Remote Edit Server. In most stations, the Myriad server or an office server 
is the ideal platform for running Remote Edit Server but that will depending 
the system specification and the level of loading on the server.

Installing Remote Edit Server 

To install Remote Edit Server make sure that you have either downloaded the 
latest version of the software from the P Squared web site 
(www.psquared.net) or that you have an installation CD with the latest version 
of the software on it. 

If you have an installation CD, put in to your PCs CD-ROM drive and a web 
page containing the CD menu should automatically start. If not then use ‘My 
Computer’ to browse the CD and double click on ‘Default.htm’ in the root of 
the drive. Once the menu page appears, select ‘Install Remote Edit Server’ 
from the menu and follow the onscreen instructions.

If you have downloaded the installation file from the P Squared web site then 
make sure it is saved in an accessible area and then when you are ready, 
double click on the ‘P Squared Myriad v3 Remote Edit Server.msi’ file.

This will then start the Installation  Wizard which will guide you through the 
Remote Edit Server installation process.

The first page in the Installation Wizard is a welcome page, click on the Next 
button to proceed.

You will then see the License page which outlines the Remote Edit Server 
software license agreement. If you wish to use Remote Edit Server then you 
must select the ‘I accept the terms of the license agreement’ option and then 
click on the Next button. If you decide that you do not agree with the License 
Agreement, select the ‘I do not accept’ option, click on Next, close this book 
and walk away slowly!

http://www.psquared.net/
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You will then be asked to type in a User Name and Organization (station) 
name. You will also be asked whether you want Remote Edit Server to be 
available to all Windows Users or just the login name you are currently using. 
It is recommended that you select ‘Anyone who uses this computer (all users)’ 
before clicking on the Next button to proceed.
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Next you will be asked to select whether you wish to perform a Compete 
installation (installs everything) or a Custom installation (allows you to select 
the components to be installed). It is highly recommended that you select 
‘Complete Installation’ before proceeding. 



13

If you select ‘Custom Installation’ then you can specify the location of the data 
folder that Remote Edit Server uses to store information.
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Which ever option you choose, click on the Next button to proceed to the next 
stage of the wizard.

Remote Edit Server will now be installed on to your PC. This may take several 
minutes depending on the speed of your PC. Once the install process is 
complete, you are ready to proceed to setting up Remote Edit Server.
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You are now ready to run Remote Edit Server for the first time.

Installing Remote Voice Tracking 

Installing Remote Voice Tracking is almost exactly the same procedure as 
outlined above (for Remote Edit Server) so you basically make sure you have 
either the latest version of the software on CD or downloaded from the P 
Squared web site. If you have an installation CD, insert it in to the CD-ROM 
drive and when the menu page appears, select the Install Remote Voice 
Tracking option from the menu. If nothing happens when you put the CD in 
the drive then use ‘My Computer’ to browse the CD and double click on the 
‘Default.htm’ page located in the root of the CD.

If you have downloaded the latest version from then save it to a safe place 
and then double click on the ‘P Squared Myriad v3 Remote Voice 
Tracking.msi’ file to start the installation process.
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Once again, the Installation wizard will guide you through the installation 
process. Follow the on screen instructions to install the Remote Voice 
Tracking software.

The first page is a welcome page, click on the Next button to continue.

Next you must agree to the accept the terms of the License Agreement. 
Highlight the ‘I Accept’ option and then click on Next.
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Type in your name and the name of your company or station (this is not 
critical). Also select whether it is just you who wants access to the software or 
all Windows users. Click on Next to proceed.
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It is recommended that you select the ‘Complete’ option on this page but if 
you would prefer to select the location of the installation and data files then 
click on the ‘Custom’ option and the select Next
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Click Install to begin the installation.
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The installation process may take several minutes depending on the of the 
PC, once finished, you will see a final summary screen.

You are now ready to run Remote Voice Tracking for the first time.

Remote Edit Server 

As we covered in the earlier sections, the Remote Edit Server application is 
installed on a PC that has access to both the Myriad network and the ‘outside 
world’ (web) in such a way as the Myriad network is protected from dangers 
such as hackers and viruses. Typically the Remote Edit Server application is 
installed on the Myriad file server or an office file server but if your servers are 
busy or you envisage using RVT heavily then it is worth consider running 
Remote Edit Server on a dedicated PC. 

So far we have installed the Remote Edit Server but have not actually run it 
for the first time, so let’s do so.

Running Remote Edit Server For The First Time

If you are running Remote Edit Server for the first time, Remote Edit Server 
will detect that it has no previous configuration data or license code and will 
walk you through setting all the information that it needs to operate. 



21

Licensing Remote Edit Server

Before you can start to configure Remote Edit Server you will need to actually 
license it. You can obtain a license code from P Squared or the agent that you 
purchased Myriad from. You will however need a specific Remote Edit Server 
license code, the system will not accept your Myriad code or a code for any 
other products.

If you are familiar with P Squared products then you will be familiar with the 
advanced license code protection that our software employs and should be 
able to go straight through the License Wizard. If not then you may find the 
section below of used.

Please note that this section of the documentation has been taken 
directly from the main Myriad documentation and as such refers to 
Myriad instead of Remote Edit Server but the process is exactly the 
same for all current generation P Squared products.

The advanced licensing procedure generates a special code (called a 
PSQUISH) that is unique to your computer. The first time that you activate 
Your P Squared product you will need to provide this code to P Squared Ltd in 
order to complete the licensing process. Subsequent codes can be obtained 
automatically (assuming you have web access) but you may have to contact 
P Squared Ltd periodically in the future. 

Manually Obtaining A License Code

The standard licensing procedure for manually obtaining a license code is:

1. Select the License Code option from the Tools menu. The License 
Wizard will run automatically the first time that you run Your P Squared 
product or if you run Your P Squared product once your license has 
expired,

2. If this is the first time that you have licensed Your P Squared product or 
you have not ticked the option to skip the introduction screen the last 
time you entered a license code, the introduction screen will be 
displayed.
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3. Read the screen and then tick the “Skip this screen in the future” option 
unless you want to read this introduction each time. The click on Next.

4. You will then see a summary of the current license status of Your P 
Squared product. In the example below, you can see that we currently 
have a valid license that is not due to expire for some months. If you 
are entering a license for the first time then this information will be 
blank. If you wish to proceed, click on the Next button.
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5. If you do not need to license Your P Squared product, the License 
Wizard will warning you before you proceed to the next screen, if you 
want to proceed anyway then click on OK.

6. The next phase is to enter your registration details. You will only have 
to do this the first time; the information will be loaded automatically on 
subsequent license procedures

The first thing that you have to enter is your P-SQUID or P Squared 
Unique ID which is your P Squared unique customer ID and will be 
provided by P Squared. Your P-SQUID will be at the top of all quotes, 
or purchase orders that you receive from P Squared and should be 
quoted whenever you contact P Squared. To enter or alter your P-
SQUID, click on the Change button and type in the new P-SQUID

Next add in your contact details by clicking on the Change button by 
the contacts summary window.



24

You are required to enter your name and a valid email address; these 
details will be used when processing requests for ‘online’ license 
renewals in the future. You may also fill in the additional information if 
you wish. Once you have finished, click on OK to return to the main 
wizard and then click on Next to move on to the next step.

7. The next step in the license wizard allows you to enter the License 
Name and Features Code for the product. Both of these will be 
provided by P Squared with the purchased product or we can give you 
the details over the phone.
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Type in the License Name exactly as it is give to you by P Squared and 
then click on the Set button. Repeat the same procedure for the 
Features Code.

N.B. It is possible to obtain a Features Code ‘online’ by clicking on the 

 button. When you select this option, the progress of the ‘online’ 
Features Code generation is shown on screen and if a code is 
successfully generated, it will be added to the Wizard window. Please 
note that this option will generally only be available to existing 
customers who have licensed Your P Squared product previously.
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Once the License Name and Features Code have been set, you can 
alter them by clicking on the appropriate Change button. If you are 
happy, however, click on Next to proceed.

8. The next screen allows you to choose the method that you want to use 
to obtain your license code.
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Each option is explained on screen as you can see from the image 
above.

In this case, let’s assume that we want to manually enter the code and 
we intend to phone P Squared to give them details needed to activate 
the product. Select ‘Manually Enter A New License Code’ and then 
click on Next.

9. The next screen displays the P-SQUISH code which is a unique code 
that is used to generate your license. The P-SQUISH is unique to your 
contact, details, the PC you are working on and the time and date that 
you generate it.
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The P-SQUISH is only valid for a few days so you should contact P 
Squared as soon as possible to let them have your P-SQUISH code. 
You can do this be either:

 Telephoning: +44 1482 383700
 Emailing: licenses@psquared.net
 Faxing To: +44 1482 383701

Once P Squared have a valid P-SQUISH code, they will then provide 
you with a License Code that you need to type in to the New License 
Code part of the screen before finally hitting Finish.

10.Clicking on Finish will end the licensing process. A short summary 
screen will be displayed before you can proceed on to using Your P 
Squared product.

mailto:licenses@psquared.net
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Automatically Obtaining A License Code

In general, the first license code that you receive will have to be processed 
manually but once all your details are registered with P Square, subsequent 
licenses can be obtained ‘online’ without the need to contact us. This means 
that you can renew your license at your convenience providing that your PC 
has a web connection. 

To obtain a license code ‘online’, follow these steps.

1. Select the License Code option from the Tools menu.
2. The introduction screen is usually skipped when renewing a license. In 

this case, the first screen you will see is the Current License Details 
screen which shows you when the current license was entered and 
when it is going to expire.
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3. Click on Next to move on to the P-SQUID and Personal Details screen. 
You only need to alter the information on this screen if it has changed. 
If not, click on Next to move on to the next screen.

4. Next you will see the License Details screen. Again, unless you need to 
need to alter any of this information, you can click on the Next button to 
move on to the next window.
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5. The License Method window allows you to select the way in which you 
want to obtain your License Code. In this case, we want to renew the 
license online so we need to make sure ‘Obtain A License Code 
Online’ is ticked and then click on Next.

6. Finally, you will see a brief summary screen before Your P Squared 
product attempts to obtain a license ‘online’. Click on Finish to begin 
the process.
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At the end of the process, you will be told whether your license code 
was successfully renewed or whether you need to contact P Squared 
to continue the licensing process.

The Remote Edit Server Settings Window
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As this is the first time we have run Remote Edit Server, the Settings window 
will automatically appear after we have finished licensing the product to allow 
you to set up the system the way that you want it to be.

The Settings window allows you to configure a number of options covering 
aspects such as how the RVT client will connect, what audio format should be 
used for downloading the beginning and end of tracks and crucially, what 
format the voice links should be uploaded in.

The Settings window is divided in to three tabs.

The Network Tab

The Network tab allows you to configure the way in which Remote Edit Server 
will communicate with the RVT clients and the location of the audio ‘cache’ 
which is used to keep a central copy of the beginning and ends of tracks as 
they are generated. The reason for this is that if Remote Edit Server has a low 
quality version of a song in the cache and a RVT client requests it, Remote 
Edit Server will send the low quality version from the cache rather than re-
compress it again. This makes the RVT process quicker but takes up space 
on the pc running Remote Edit Server.

The options on the Network Tab are examined below.

Connection: Command Port

The Command Port setting option allows you to select a specific port for 
communication between Remote Edit Server and the connected RVT client. 
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The Command Port is used for all communication between the two software 
applications but is not used for transferring audio data. 

You must ensure that the port that you set is ‘open’ on your Firewall or RVT 
clients will not be able to connect to your Remote Edit Server. For advice on 
how to open ports on your Firewall, please refer the manufacturers’ 
instructions.

The default setting for this option is Command Port = 6940 and it is 
recommended that you do not alter this unless you need to for a valid 
technical reason.

Connection: Data Port

Just as the Command Port allows you to specify the port that is used for 
command communications, the Data Port option allows you to set the port 
used to actually transfer audio files between Remote Edit Server and the 
Remote Voice Tracking applications.

As before, you must ensure that what ever port you select is also ‘opened’ on 
your Firewall or RVT will not be able to connect with Remote Edit Server.

The default for this setting is 6941 and it is recommended that you do not alter 
this unless you have to for a valid technical reason.

Connection: Close The Connection When Idle For More Than X 
Minutes

This option allows you to select a maximum period of inactivity for a RVT 
client to remain connected to the Remote Edit Server. As mentioned above, 
Remote Edit Server can only accept one connection at a time so if you had an 
absent minded jock who remotely voice tracked and then went out for the 
evening without disconnecting then no one else could use the system without 
this setting.

If you sent this to say 5 minutes then if the RVT client does not actually 
communicate with Remote Edit Server for 5 minutes or more, Remote Edit 
Server will ‘kill’ the connection and become available for other RVT clients to 
connect. Of course, the original RVT client can reconnect if they need to.

Keep A Local Cache Of Audio Files

In order to fully understand what this setting is for, it is important to 
understand how Remote Edit Server works when a Remote Voice Tracking 
client starts a Remote Voice Tracking session. The steps involved are 
outlined below.
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1. The RVT client connects to the Remote Edit Server.
2. Remote Edit Server send RVT a copy of the Station Log which is 

displayed to the remote user via RVT.
3. The remote user decides where they want to record a voice link and 

initiates the process by highlighting the Log Item they want to be 
playing at the end of the Voice Track and pressing the <SPACE BAR>.

4. RVT requests the last XX seconds of the previous track and the first 
XX seconds of the next track from the Remote Edit Server. The 
Remote Edit Server opens the two requested tracks, chops out the last 
XX second and first XX seconds respectively, encodes them to 
whatever quality has been selected and sends them to the RVT client.

5. Once the RVT client has them, it plays them to the user and the user 
can record his or her Voice Track in the normal way. RVT plays the last 
XX seconds (in low quality) to the user, they can record whenever they 
are ready and trigger the first XX seconds of the next track at the 
appropriate time.

6. Once the link is finished, the recorded Voice Track is uploaded to the 
Remote Edit Server along with all the timing information for the link.

The important step to consider here is step 4 where Remote Edit Server has 
to open the requested files, chop out the bits it needs and encode them at the 
appropriate quality / format. If this option is not ticked then each time Remote 
Edit Server performs this operation, it discards the ‘preview’ versions of the 
tracks once it has sent them to RVT but if you tick this option then Remote 
Edit Server will then save them in the cache and the next time a RVT client 
requests them, it will used the previously generated copy (as long as nothing 
has changed in the mean time). This speeds up operations and reduces the 
load on the Remote Edit Server.

Keep A Local Cache Of Audio Files: Audio Cache Folder

The only negative aspect is that the cached files take up hard disk space 
either on the local box or on another network location. 
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You can use the Audio Cache Folder field to select the location of the file 
cache to set it to either be in a local folder or somewhere on the network. 

You can use the Select Folder button to browse for the fold location that you 
wish to use.

Keep A Local Cache Of Audio Files: Allow The Client To Clear The 
Server Cache
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This option allows you to set whether the remote RVT user has the ability to 
delete all of the audio files in the local Remote Edit Server cache. If this option 
is enabled then the RVT client gets a button that will delete all of the audio 
files in the Remote Edit Server cache forcing Remote Edit Server to generate 
each requested ‘preview’ again. 

It is recommended that this option is switched off unless you have a specific 
reason to do so.

The Audio Tab

The Audio Tab is used to set the audio quality and format of the ‘preview’ files 
that are sent to the RVT client when it requests the last XX seconds of a Log 
Item and first XX seconds of the next item in the Log in order to allow the user 
to record a Voice Track.

It also determines the audio quality and format in which the Voice Track is 
recorded. This may seem strange but if you think about it, you want to be able 
to control the audio format and quality that Voice Tracks are recorded at to 
allow you to have a consistent sound for your station output. If you allowed 
the remote user to set this recording quality, a presenter of a slower web link 
may decided that they want to record all their links with a heavier compression 
scheme but this will have a negative effect on the overall sound of your 
station.

Finally, Remote Edit Server has the ability to Normalise each Voice Track that 
is submitted by RVT clients. This allows you to have some control over the 
audio level at which your Voice Tracks are produced at.
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Download Format

The Download Format option allows you to select the audio quality for the 
‘preview’ audio files sent to the RVT client. It is recommended to keep the 
quality fairly low in order facilitate faster download speeds for the remote user 
and as all they need to be able to do is hear the audio in order to record a 
Voice Track, something like 28Kbps should be adequate.

To alter the Download Format, click on the Format Select button (to the right) 
and select the format that you wish to use from the Chose Audio Format 
Window.

Use the Profile drop down list to see all of the available options, and select the 
option that most closely matches your needs.
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Please note that you can only select Window Media Audio (WMA) from the 
Audio Format drop down menu as all outgoing ‘preview’ audio files are 
compressed using windows media format audio.

Upload Format

The Upload Format option allows you to set the audio quality and format for 
the Voice Tracks that are recorded remotely and uploaded to the Remote Edit 
Server. Once again, use the Format Select button to change the Upload 
Format.

Once again, this opens the Choose Audio Format window which is used to 
select the Upload quality and also the audio format.
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In this case, because you may not wish the uploaded Voice Tracks to be 
compressed at all, you can use the Audio Format option to switch between 
Window Media Audio (compressed) and Windows WAV (non compressed or 
linear audio).

If you select WMA then you can use the Profile drop down list to select the 
audio quality.

If you select Windows WAV Audio format then you get slightly different 
options.
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In this case, you can use the Format drop down to switch between IMA 
ADPCM (4:1 compressed) or PCM (non compressed).

You can also use the Sample Rate drop down to select the sample rate that 
you wish to use (44,100Hz is CD quality and recommended) as well as 
whether the file should be mono or stereo.

Upload Format: Normalise Links To XX%
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This option allows you to set Remote Edit Server to automatically normalise 
all submitted files to a preset level.

With this option ticked Remote Edit Server will scan through the audio after it 
has uploaded it, find the loudest point and then work out how much it will need 
to amplify or reduce the volume by in order for this point to make it the same 
as the Normalise To percentage. Once it has this value, it will then apply the 
same amplification / reduction to the rest of the file and hence the file will be 
normalised. The important thing is if all the audio files uploaded are 
normalised to the same value then the loudest point in each file will be exactly 
the same.

The percentage value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% presenting silence. 

Myriad can also be set to normalise all imported and ripped audio to a preset 
percentage. It may be that you want to set the Normalise setting in Remote 
Edit Server to be the same as Myriad but also, you may decide that Voice 
Tracks should be normalised to a slightly higher level which is why it can be 
set separately.

The Other Tab

The Other tab is used to house a few miscellaneous options that do not fall 
under the Network or Audio categories.

Security Options: Allow Users With Blank Passwords To Login
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Remote Voice Tracking users have to log in to the Remote Edit Server with 
their standard Myriad User Name and password and Remote Edit Server then 
checks this against the P Squared Directory top ensure they are a valid User 
and that they have access rights to edit the Log remotely. If they do then they 
are allows to proceed to using RVT to edit the log and record Voice Tracks.

The problem is that Myriad does allow Users to opt to have blank passwords 
as part of their login detail and whilst this may be ok inside your station (where 
only your staff are allowed), it may represent an unacceptable security risk for 
Remote Voice Tracking as the last thing you want is a complete stranger (or 
someone malicious) editing your log or recording Voice Tracks that will be 
broadcast ‘on air’ unless you intervene to stop them.

It is recommended that Users be forced to keep passwords in order to access 
the system. This can be achieved by switching this option off.

Logging: Store Log Files Here

Remote Edit Server stores a constant log of RVT activity to provide you with 
information about who has been doing what should you need it.

This option allows you to set a local or network folder location for Remote Edit 
Server to store this log information in. To set an alternative location, click on 
the Select Folder button and browse to the location you wish to use.
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Other Options: Minimise To The System Tray

This option allows you to set what happens to Remote Edit Server when it is 
minimised. If this option is ticked then when you minimise the Remote Edit 
Server application, instead of just minimising on the Start Bar like a normal 
application, it goes to a small icon in the ‘sys tray’ which is next to the clock on 
the right hand side of the Start Bar.

This option is useful if you are running Remote Edit Server on a machine that 
also performs other tasks as once Remote Edit Server is configured and 
running, you can pretty much forget about it.

The Remote Edit Server Settings Window Summary

Once you are happy with all of the settings on the Remote Edit Server 
Settings Window, click on the OK button and your settings will be saved and 
Remote Edit Server will finish loading for the first time.
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The Remote Edit Server General Screen Layout

The Remote Edit Server general screen layout is outlined below.

These sections are explained in more detail below.

Menu Options

The Menu Options section provides access to a range of tools and settings to 
allow you to configure both Remote Edit Server and your Myriad system as a 
whole. 

The majority of these settings have already been covered in the main Myriad 
documentation or earlier in this manual so the brief guide below is intended as 
an overview only.

File > Reset Connection

This option is used to cut the connection to a RVT client and reset the system 
to allow another RVT client to connect.

You can use this option to drop any connections that may have inadvertently 
been left open or if some problem is preventing the RVT client from correctly 
ending the session.

File > Exit
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This option is used to close the Remote Edit Server application which will also 
drop all active RVT client connections.

Tools > Pre Seed Audio Cache

In the previous section, we looked at how Remote Edit Server can be 
configured to store a cache of audio files that have already been chopped to 
the correct size and encoded at the correct rate. That way, if an RVT client 
requests an audio files that is already cached then Remote Edit Server will 
sent RVT the cached version which saves time and resources. Normally, 
Remote Edit Server will build up a sizable cache of audio files over time but 
as they are only created as RVT requests them, it can take a while (if ever) for 
a useful amount of the audio files to be stored in the cache.

The Pre Seed Cache option on the Tools menu counteracts this by allow you 
to set Remote Edit Server to work through a range of Carts on the Audio Wall 
and generate the chopped and compressed audio preview files for all of the 
selected Carts regardless of whether a RVT client has requested them.

If you are using a large Audio Wall then this can considerably speed up the 
RVT process as the user will not have to wait while Remote Edit Server 
extracts, chops and compresses audio files, they will already be in the correct 
format and ready to be downloaded. The only downside is that the cached 
audio files will take up hard disk space on your system (see Settings Window 
> The Network Tab for more details).

To use this facility, select the Pre Seed Audio Cache option on the Tools 
menu.

Next, use the Start Audio Reference and End Audio Reference fields to type 
in the start and end Cart Slot Numbers that you wish to use. If you are not 
sure, you can click on the Cart Browser buttons to use the Cart Browser to 
select the Start and End Carts.
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N.B. See Cart Browser section of main Myriad User Guide for more details on 
using the Cart Browser.

If you tick the ‘Clear Existing Cached Items’ option then Remote Edit Server 
will work its way through the selected Cart Range and generate cached audio 
files for each Cart in that range (well not the blank ones!). If you leave this 
option un-ticked (the default) then Remote Edit Server will not overwrite any 
audio files that already exist which effectively means it will only add in new 
Carts or Carts that have changed. This is useful as you can run this facility 
periodically to keep your cached files roughly in sync with your Audio Wall.

Remember that is RVT client requests a Cart that is not cached, Remote Edit 
Server will generate it anyway so this is not critical.

Finally, you can click on the Calculate Required Disk Space button to get 
Remote Edit Server to scan through the requested Cart Range and calculate 
how much space will be required to Pre Seed the Audio Cache with the 
selected Carts.

This allows you to see how much space will be needed and avoids running 
the tool if you do not have enough space to complete the operation.
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Once you are happy with the settings, click on the OK button to begin the Pre 
Seed process.

As you will see, Remote Edit Server continues to operate normally while it is 
generating the audio files in the background. 

Once the process is complete, Remote Edit Server will let you know.

Tools > Clear Audio Cache

As you would expect, this option is used to clear the audio cache that Remote 
Edit Server has stored so that no audio files exist in the cache. If you select 
this option, you will first be asked to confirm that you want to proceed.
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If you select Yes at this stage then Remote Edit Server will delete all of the 
audio files stored in the cache.

Settings > Audio Wall Settings

This provides access to the Myriad Audio Wall Settings window which is used 
to set the location of the audio files that make up the Myriad Audio Wall as 
well as the settings that the Audio Wall File Locations use.

CAUTION: This is a Myriad setting; altering this setting will effect Myriad 
as well as Remote Edit Server. You should only use this feature if you 
know what you are doing and mean to re-configure your Myriad system 
as well.

The first thing that you will see with this option is a warning that any changes 
made in this window will affect Myriad.

Click on Ok to proceed.
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Next you will see a warning that changing the file locations will invalidate the 
audio file cache and Remote Edit Server will delete the old audio file cache if 
you set up a new Myriad Audio Wall File Location (which makes sense as the 
old cache will be invalid).

If you wish to proceed, click on the Yes option.

This provides access to the standard Myriad Audio Wall File Locations 
window which is used to change the location of the audio files Myriad uses for 
the Audio Wall and also to configure the Global Audio Wall Settings.

The settings on this window are covered in the main Myriad User Guide and 
are not within the scope of this document.

Settings > Station Database Settings

The option provides access to the Myriad Station Database Settings which 
are used to configure individual Station Databases in Myriad.
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CAUTION: This is a Myriad setting; altering this setting will effect Myriad 
as well as Remote Edit Server. You should only use this feature if you 
know what you are doing and mean to re-configure your Myriad system 
as well.

If you have more than one Station Database, you will first be asked to select 
the Station Database you want to work with.

Highlight the Station Database you wish to work with and then click on Ok.
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The Station Database Settings window will then open. You can use this to 
configure a wide array of options that will affect all Myriad workstations that 
access the Station Database you are working on so be careful!

The Station Database Settings window is covered in detail in the main Myriad 
Users Guide and is not covered in this documentation.

Settings > P Squared Directory Settings

This option offers access to the P Squared Directory Settings window which is 
used to configure security groups in Myriad as well as a range of other User 
related features.

CAUTION: This is a Myriad setting; altering this setting will effect Myriad 
as well as Remote Edit Server. You should only use this feature if you
know what you are doing and mean to re-configure your Myriad system 
as well.

The Directory Settings window is covered in detail in the main Myriad User 
Guide and is not re-covered in this manual.

Tools > Myriad Settings
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The Myriad settings option is used to access the Myriad Settings window 
which allows you to alter a number of local and remote Myriad related 
features.

CAUTION: This is a Myriad setting; altering this setting will effect Myriad 
as well as Remote Edit Server. You should only use this feature if you 
know what you are doing and mean to re-configure your Myriad system 
as well.

When you access this option, the first thing you will see is a warning that you 
are about to alter the settings for Myriad not necessarily Remote Edit Server.

You will then proceed to the Myriad Settings window which offers access to all 
the Myriad settings.
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This section is covered in detail in the main Myriad User Guide so you should 
refer to that document for more details on the options offered here.

Tools > Program Settings

At last, something that is fully Remote Edit Server related!

Selecting this option will open the Remote Edit Server Settings Window which 
is covered in detail in the Remote Edit Server Settings Window section earlier 
in this manual.

The Remote Edit Server Settings window is divided in to three tabs.

1. Network – for setting up the way Remote Edit Server communicates 
with RVT clients.

2. Audio – for setting up the audio quality and format for the audio files 
that are downloaded and uploaded.

3. Other – A range of general settings not related to network or audio 
functions.

All of the options on this window are covered in detail in the Remote Edit 
Server Settings Window section earlier in the manual.

Tools > License Details
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This option is used to access the Remote Edit Server License Wizard which is 
used to enter an updated license code or check to see when you current 
license expires.

You may have to enter a new license code periodically (as an anti-piracy 
measure) in which case you will need to use this wizard from time to time.

A full walk through of the License Wizard can be found in the Licensing 
Remote Edit Server section earlier in this user guide.

Help > Update Information

This option displays a text file that is installed with each new build of Remote 
Edit Server, which details any changes, enhancements or bug fixes that the 
new (and previous) versions of the software contains.
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It is worth a read through each time you install a new version of the software 
as they may be a cool new feature that you would not otherwise know about.

Help > P Squared On The Web

This option provides direct access to a range of P Squared web sites to give 
you a quick way to get to any P Squared web site.
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Selecting an option from this list will open the selected web site in your PCs 
default web browser.

Help > About Myriad

The About Myriad option opens the About Myriad which is principle used to 
determine the exact version number of the software you are using.
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It also contains some other useful information that P Squared engineers may 
ask for when dealing with any requests you may have.

Current User

The Current User section of Remote Edit Server shows the Username of the 
person who is currently logging in to Remote Edit Server via a RVT client.

This Username will be the same as the Username that they use to log in to 
Myriad when they are at the station.

Connection Details

The Connect Details section shows the date and time when the currently 
connected User logged on to the Remote Edit Server.
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Event History

The Event History window shows a rolling list of the tasks performed by the 
user remotely using RVT.

As you will see, Remote Edit Server keeps a fairly comprehensive lists of the 
actions of the RVT user and these are also stored as Log Files to allow you to 
look back at previous activity.
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The Event History window acts as a very useful trouble shooting tool is the 
remote user is having difficulty performing a particular task.

Trouble Shooting

In this section we will look at some of the more common issues you may face 
with Remote Edit Server.

Networks, Firewalls & Port Forwarding

The biggest issue you are likely to face with Remote Edit Server is that in 
order to allow Remote Voice Tracking clients to connect to the Remote Edit 
Server you will have to configure your network and firewall to firstly allow 
connections to the PC running Remote Edit Server and also open up the 
Ports that Remote Edit Server is using for Data and Communications.

Unfortunately, the assistance that P Squared can offer in this area is very 
limited as each network and security system is different. 

If you are using Windows XP’s in built software firewall then the first time you 
run Remote Edit Server, the XP firewall will detect the need for external 
connections and ask you whether you wish to Block or Unblock connections 
to this application.

You MUST click on the Unblock option when this window appears.
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The problem is that most stations will also operate a hardware firewall of 
some description and this will also need to be configured to allow Remote Edit 
Server to communicate with the ‘outside world’. 

You can view the Ports that Remote Edit Server will require to be ‘open’ by 
selected the Settings Menu > Program Settings option and switching to the 
Network tab.

Here you can view and edit the two Ports that Remote Edit Server and 
Remote Voice Tracking will use to communicate, it is these ports that must be 
‘open’ on your firewall and must ‘forward’ connections to the Port to the 
Remote Edit Server PC.

This is known as Port Forwarding and it basically means that whenever an 
external PC connects to your firewall using the selected Ports, the firewall will 
automatically pass the information on to a specific PC, in this case the 
Remote Edit Server. The Remote Voice Tracking then connects to the firewall 
at the station (not the Remote Edit Server directly.



62

The diagram below shows the general overview of what needs to happen.
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The way in which this needs to be set up varies with different firewall 
equipment and network configurations and unfortunately, P Squared are 
unable to offer technical support with configuring firewalls.
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The screen shot below shows an example configuration when working with a 
DrayTek Vigor 2900 Series firewall but it will be different on other makes and 
models.

For details on how to work with your stations firewall, please consult your IT 
department or the firewall manufacturer’s documentation.

If you require further assistance, then P Squared may be able to help but this 
would result in a small support charge as it is not covered by any support 
contracts with P Squared.

Using Remote Edit Server With A VPN Connection
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As an alternative to the Port Forwarding method outlined above, if your station 
is set up allow VPN (Virtual Private Network) connections then this provides a 
much simpler method for allowing Remote Voice Tracking Clients to connect 
to your Remote Edit Server.

VPN allows users in the ‘real world’ to login to your corporate network as if 
they were in your building but instead of being physically at your site, their 
connection is ‘tunnelled’ through the web.

VPN’s are great because if a user logs in to your network via VPN, they are 
effectively on your network and as such can access the resources within your 
network that you allow them. This means that once a Remote Voice Tracking 
client has logging in to your network via VPN, they can then connect to the 
Remote Edit Server directly using the Remote Edit Server name.

This method is undoubtedly simpler providing your network is already 
configured to accept VPN connections. If your network is not configured for 
VPN’s then you will need to consult your IT department to determine whether 
your equipment will support VPN’s and also to get advice on how to configure 
tyour equipment for VPN’s. Unfortunately, P Squared technical support are 
not able to assist in this area.

The VPN method appears to be idea but there a couple of things that you 
need to consider.

 When a user logs in to your network via VPN, it is as if they have 
logged in use a PC within your building and will have access to all of 
the network resources that would be available if they used the same 
username and password in a PC in your building. This may be fine for 
employees but if you are using freelance presenters, you may not wish 
to give them so much access.
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 Not all firewall equipment allows VPN connections and sometime, 
configuring VPN access securely can be challenging.

If you can over come these issues then using a VPN connection provides and 
excellent alternative to the ‘port forward’ method outlined in the previous 
section.
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Remote Voice Tracking (RVT)

Remote Voice Tracking (or RVT) is the stand alone application that is installed 
at all remote sites or roving PCs that you wish to have access to your Station 
Log via the Remote Edit Server. The RVT client is designed to look and act 
just like the Log Screen in Myriad and it allows you to review and edit the 
Station Log, edit segues and record Voice Tracks locally which are then 
automatically uploaded to the station and inserted in to the Station Log by the 
Remote Edit Server.

If you are familiar with Voice Tracking in Myriad then this screen will look very 
familiar indeed and you should be able to largely use RVT without any 
additional information or training.

As the RVT allows you to work with the Log Screen and record Voice Tracks 
in almost exactly the same way as Myriad and both areas are covered in a 
great deal of detail in the main Myriad Users Guide, it is assumed in this 
documentation that you are familiar with the concepts and operations of 
Myriad and hence many of the features will only be covered partial detail.
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Setting The Sound Devices That Remote Voice Tracking Will 
Use

Unlike Myriad which allows you to specify what sound device to use for 
playback and recording, Remote Voice Tracking uses the default Windows 
sound devices for playback and recording.

The problem is that you may have more that one sound enabled device 
attached to your PC (especially if you have things like USB modems 
connected).

In order to alter the default Windows sound devices, click on the Start button 
and select Control Panel. Control Panel can be viewed in two different ways in 
Windows XP depending on how you have set up your PC.

Category View
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Classic View

If you are in Category View, click on ‘Sounds, Speech, & Audio Devices’ 
option, then the Sound & Audio Devices option which will open the Sound and 
Audio Devices Properties window.

If you are in classic view, double click on the Sounds and Audio Devices 
Option.

In both cases, the Sound and Audio Devices Properties window will open.
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Switch to the Audio tab and then use the drop down list to select the Sound 
Playback and Sound Recording Default Devices.

Running Remote Voice Tracking For The First Time

Once you have successfully installed Remote Voice Tracking, you are ready 
to run it for the first time.

Unlike Remote Edit Server (and most other P Squared products), Remote 
Voice Tracking is not licensed which means you are free to install it on any 
PC that you wish and you will not need to license or register the installation 
with P Squared. This in tern means that the first time you run Remote Voice 
Tracking, you will not be asked to complete the License Wizard, instead, 
Remote Voice Tracking will proceed directly to the Connection Settings 
screen.
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You use this screen to enter the settings that Remote Voice Tracking will use 
to connect the desired Remote Edit Server. This window is also used to login 
to the Remote Edit Server each time that you restart Remote Voice Tracking.

The Connection Settings Window / Login Window

The Connection Settings window is used to configure the settings that 
Remote Voice Tracking will use to connect to the Remote Edit Server and 
also to provide you with the mechanism for logging in and out of the Remote 
Edit Server you are connecting two.

The Connection Setting window can be viewed in two modes. 

The Connection Window In Simple Mode



72

In Simple Mode, you can type in your Username and Password as well as the 
name of the Remote Edit Server you want to connect to. Remote Voice 
Tracking uses either the default settings for Remote Edit Servers that it has 
not connected to before, all the altered settings that you used last time when 
connecting to a Remote Edit Server that you have set up previously.

You can opt to have Remote Voice Tracking save your password by ticking 
the Remember Password so that next time Remote Voice Tracking will allow 
you to connect directly.

The Connection Window In Advanced Mode

You can also view the Connecting Settings window in Advanced Mode by 
clicking on the Options button on the bottom right of the window.
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This will expand the Connection Settings window in to Advanced Mode which 
allows you to configure a number of additional settings and preferences.

The Connection Settings window in Advanced Mode is divided up in to four 
tabs. The options in each tab are examined in the sections below.

The General Tab

The General tab is used to set the general connection details for connecting 
to a Remote Edit Server and is very similar to the Simple Mode view outlined 
above with the exception that you can also set the specific Port Number to 
use for the Data Port and the Communications Port. 

Each of the options on this tab are outlined below.

 Username – This allows you to type in the User Name that you wish to 
use to login to the Remote Edit Server. This User Name should be the 
same as the User Name you use to login to Myriad when you are using 
it at the station.

 Password – You can type in the Password that is linked to your 
Username in this box. This is the same as the Password you use to 
login in to Myriad when you are at the station.

Note: Users in Myriad do not have access rights to remotely edit the 
Station Log by default so you will have to ensure that your system 
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administrator has enabled you to remotely edit the Station Log prior to 
attempting to login remotely using Remote Voice Tracking.

 Remember Password – Just as it says, if you tick this box then 
Remote Voice Tracking will remember your Password next time saving 
you having to type it in again.

 Server – This is the Server Name or IP address of the Remote Edit 
Server that you want to connect to. When connecting over the ‘real 
world’ you will probably use an IP address (like 123.321.111.222 – this 
is not a real address by the way so don’t bother trying it!) or real world 
server name (such as Remote Edit Server.mystation.com).

 Data Port – This is the specific Port that Remote Voice Tracking will 
use to communicate with Remote Edit Server for the purposes of 
transferring audio files back and forth. It is important that this Port 
number is set to be the same as the Data Port number on the Remote 
Edit Server and that the Firewalls at both the radio station and the 
remote site also have the select Port number ‘open’ i.e. the Firewalls at 
both sites allow data to pass through those Ports.

 Command Port – This is basically the same thing as the Data Port 
except that Remote Edit Server and Remote Voice Tracking use this 
port for communication only, no audio data is transferred using this 
Port. This makes communication between the two applications always 
possible. Just as with the Data Port, it is important that this Port 
number is set to be the same as the Data Port number on the Remote 
Edit Server and that the Firewalls at both the radio station and the 
remote site also have the select Port number ‘open’ i.e. the Firewalls at 
both sites allow data to pass through those Ports.

The Station Database Tab

The Station Database tab allows you to configure what Remote Voice 
Tracking will do regarding the Station Database once it has successfully 
connected with Remote Edit Server.
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There is only one option on this tab which it the option to ‘Open The Last 
Station Database You Used’.

If this option is ticked then Remote Voice Tracking will attempt to 
automatically open the Station Database that you last used when connected 
to the Remote Edit Server. The caption below shows the description of the 
Station Database that you last used to allow you to see if it is the correct one.

I many cases, your station will only have one Station Database anyway so 
you do not have to worry about this setting but if your station does have more 
than one Station Database (say for example if it is an AM and FM station) 
then you may wish to un-tick this option so that Remote Voice Tracking asks 
you which Station Database you wish to work with each time you connect to 
the Remote Edit Server.
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The Local Resources Tab

The Local Resources tab is used to configure the location and size of the local 
audio file cache that Remote Voice Tracking generates to speed up 
operations.

Just as the Remote Edit Server keeps a copy of the ‘preview’ carts that it 
generates, the Remote Voice Tracking will store a copy of the ‘preview’ Carts 
that it downloads and if it needs to use them again (and the original has not 
changed) then Remote Voice Tracking will use the ‘preview’ version from the 
local cache first, saving then need to download the file again.

You can use the Local Resource tab to set a folder location to store the 
cached ‘preview’ Carts in and also to set a maximum space that Remote 
Voice Tracking can use to store cached audio files to prevent it taking up all 
the space on your hard disk.

You can also use the ‘Override Level Trigger’ setting to override the generic 
volume level at which Remote Voice Tracking will automatically start 
recording when you are doing a Voice Link. Normally, this setting if fixed at 
the station but because you may be using very different equipment at your 
remote location so the threshold level set at the station may be inappropriate.

The options on the Local Resources tab are outlined below.

 Cache Folder – This allows you to set the folder location for Remote 
Voice Tracking to store the files that it downloads, to be accessed next 
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time it needs them (and assuming nothing has changed at the Remote 

Edit Server end). You can use the Browse Folder  button to select a 
local or network location to keep the cached audio files.

 Max Cache Size – This setting allows you to set an upper limit to the 
amount of files that Remote Voice Tracking will be able to store in the 
local audio file cache. Type in the maximum amount of space (in MB) 
that you want Remote Voice Tracking to use. If the audio file cache 
exceeds this size, Remote Voice Tracking will automatically delete files 
from the cache starting with the files last used the longest ago. It also 
shows the percentage of the overall capacity of the drive you have 
selected to the right of the Max Cache Size field.

 Override Level Trigger Settings In The Station Database – By 
default, Remote Voice Tracking will use the same volume threshold 
when detecting voice for recording, as Myriad station at the station you 
are connected to. The problem is that whist it may be fine for Myriad to 
start recording when the incoming volume rises above 5% in a sound 
proof studio with professional mic’s, the situation may be different at a 
remote location so it is import for you to set the record trigger level that 
is suitable for the environment you are working on. If you tick this 
option then Remote Voice Tracking will ignore the settings given to it 
by Remote Edit Server and instead will use the trigger level volume you 
set locally.

In the example above, Remote Voice Tracking will not use the trigger 
level setting in the Station Database but instead will start recording 
when the incoming audio level reaches 30% during Voice Tracking.

You can also opt to override the Station Database setting and not use 
Trigger Level recording at all by un-ticking the ‘Automatically Start 
Recording…’ option (as above). In this situation, Remote Voice 
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Tracking will not automatically start recording regardless of incoming 
volume and it will be up to the presenter to manually start recording 
using either the <SPACE BAR> or the on screen button.

The percentage value refers to the incoming audio volume of the 
selected input channel on your sound card (which will be the preferred 
recording device in Control Panel > Sound & Audio Devices > Audio 
Tab) and the percentage value is relative to the maximum acceptable 
input to the sound card. E.G. 100% is the loudest input the sound card 
can accept and 0% is silence. Setting the Trigger Level for a particular 
environment is a little bit of trial and error but once set you should not 
need to alter it in the future.

The Profiles Tab

The Profiles tab is used for saving the settings in the Connection Settings 
window to a special profiles file that can then be loaded again at a latter date.

To save a Remote Voice Tracking Profile, ensure the system is set up the 
way you want it and then click on the Save As button on the Profiles tab.
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You can then select the name and location of the special Remote Voice 
Tracking Profile file that Remote Voice Tracking uses to store the data.

To load a previously saved Profile file, go to the Profiles tab and click on the 
Open button. You can then select the Profile file that you wish to load.
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Once Remote Voice Tracking has loaded the settings, it will let you know.

These Profile files are really useful if you are using Remote Voice Tracking to 
work for several radio stations as then each station has it’s own Profile and 
the settings are kept fully separate.

Connecting To A Remote Edit Server

Once you are happy that you have provided all of the information needed to 
connect to Remote Edit Server, click on the Connect button to begin the 
connection.



81

If there is a problem connecting or a problem with your Username and 
Password then Remote Voice Tracking will tell you so (see error message 
windows below for examples), but assuming that all the settings are correct 
then Remote Voice Tracking should connect to Remote Edit Server without 
any further issues.
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If you are running Remote Voice Tracking for the first time (and your station 
has more than one Station Database) or you have un-ticked the ‘Open Last 
Station Database’ option then you will be asked to select the Station 
Database that you want to work with.

Highlight the Station Database you want and click on Ok.
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You will then be in Remote Voice Tracking!

The Remote Voice Tracking General Screen Layout

The general screen layout of Remote Voice Tracking will be familiar to anyone 
who has used Myriad v3 before but we will just recap over the key elements to 
refresh your memory.
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The reason that the general layout will be familiar with most Myriad v3 users 
is that it is virtually identical to the Log Screen in Myriad and it is designed to 
act and feel exactly the same so that editing the Log and recording Voice 
Tracks is as natural as doing it in the studio.

Each of these areas are explained in a little more detail below.

The Disconnect Button

The Disconnect button is used to manually disconnect from the Remote Edit 
Server that your are currently connected to. This will close the connection as 
well as shut down the main RVT screen and return to the Connection Settings 
window.

You can also so the same thing using the Disconnect From Myriad option on 
the File menu.
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The Refresh Button

The Refresh button is used to manually refresh the data displayed on the RVT 
screen with the latest information from Remote Edit Server. Under normal 
conditions, RVT will automatically refresh when the following happens.

 You scroll up or down the Log by a page, i.e. you move off the top of 
the bottom of the log and RVT gets a new page of Log details from 
Remote Edit Server.

 You edit and segue.
 Your record a Voice Link.

Other than these situations, RVT does not automatically refresh the Log 
information displayed so if you want to check that it is fully up to date you will 
need to click on the Refresh button.

The Scheduled Log

The Scheduled Log section displays the Scheduled Log information for the 
time and date you are working with. This Log Screen is exactly the same 
format and layout as the Log Screen in Myriad and it operates in much the 
same way. The list below outlines the things you can do in Remote Voice 
Tracking with the Scheduled Log.

 Move Log Items – You can move Log Items up and down the 
Scheduled Log by dragging them using the left mouse button.

 Soft Delete Log Items – You can Soft Delete Log Items by clicking on  
the Log Item Icon on the left hand side of the Log Item.

Once Soft Deleted, the Log Item remains in the Log but Myriad will not 
play it as part of Active Playout. You can restore a Soft Deleted Log 
Item by clicking on the Log Item Icon again.

You can also Soft Delete / Restore Log Items using the Schedule Log 
right click menu in Remote Voice Tracking.

 Preview Log Items – You can preview Log Items by selecting the item 
you want to preview and then either clicking on the Preview button or 
selecting the Preview option on the right click menu. Remote Voice 
Tracking will then download a low quality version of the Log Item from 
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Remote Edit Server and load it in to a Cart Player once the download is 
complete.

 Insert Carts In To The Schedule Log – You can insert Carts in to the 
Schedule Log using the Carts button to open the Cart Browser and 
then dragging the Cart you want to insert to the point in the Log you 
want to place it.

 Review / Edit Segues – You can use the Segue Editor (in either mini 
or full mode) to review segues and edit them in the same way as you 
would with Myriad. Remote Voice Tracking will automatically download 
any Log Items that it needs in order to allow you to preview a segue. 
When you are happy, click on the Save button and Remote Voice 
Tracking will update Remote Edit Server with the new segue 
information.

 Record Voice Tracks – Obviously that is the whole point!

The RVT Log Screen Right Click Menu

You can right click on Log Items in the Scheduled Log to access the Remote 
Voice Tracking right click menu which is a ‘cut down’ version of the right click 
menu available on the Log Screen in Myriad.

Change Log Item’s Ending

The Change Ending option allows you to alter the Segue Type for the Log 
Item that you right clicked on. When you select the Change Ending option, the 
menu expands to allow you to select the Segue Type that you want to change 
the Log Item to use. The options are:
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 Stop At The End And Wait – This will change the Segue Type to be a 
Red (Stop) Segue Type which means that at the end of the Log Item, 
Myriad will not start the next Log Item until the presenter manually 
triggers it. This is only applicable when in Live or Preview Live Playout 
Modes.

 Segue To The Next Item – This will change the Segue Type to be a 
Green (Go) Segue Type which means that at the end of the Log Item, 
Myriad will automatically segue in to the next Log Item. This is valid for 
all Active Playout Modes.

 Sweep In To Intro – This will change the Segue Type to be a Yellow 
(Sweep) Segue Type which means the Myriad will use the default 
sweeper style to embed the Log Item in to the Intro of the next Log 
Item. This is valid in all Active Playout Modes.

Special Case – Convert Log Item To Voice Link

The Convert To Link option is only available on the right click menu when you 
have right clicked on a Log Item that is a Link.

If you select the Convert To Voice Link option, the Link in question is 
converted to be a Voice Link Log Item and will be treated just like any other 
Voice Link which includes Myriad ‘ducking’ the audio playback volume of 
other Carts when the Voice Link is playing. You can also edit the new Voice 
Link item using the Segue Editor (in either mini or full mode) to get the perfect 
mix.
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Special Case – Convert Log Item To Cart

The Convert To Cart right click option only appears when you right click on a 
Voice Link Log Item in the Schedule Log.

Selecting this option will convert to the selected Voice Link to be a standard 
Cart Log Item which means it will be played back without being embedded in 
to the Intro of the next Log Item (unless you manually alter it to have a Yellow 
(Sweep) Segue Type) and Myriad will not ‘duck’ the audio volume on any 
other Carts while it is playing (again unless you manually set it to be a Yellow 
(Sweep) Segue Type.

Change Log Item’s Type

The Change Type option allows you to change the Log Item Type for the Log 
Item you right clicked on. Again, selecting this option will cause an expanded 
menu to pop out.



89

The options are:

 Cart – Changes the selected Log Item to be a Cart.
 Link – Changes the selected Log Item to be a Link.
 Song - Changes the selected Log Item to be a Song
 Advert - Changes the selected Log Item to be a Advert.

Delete Log Item

The Delete menu option is used to delete the Log Item that you have right 
clicked on. Expanding the Delete menu shows the available options.

There is an important distinction between Soft Deleting a Log Item and 
Permanently Deleting a Log Item. When you Soft Delete a Log Item, the Log 
Item appears ‘greyed out’ in the Schedule Log and Myriad will act as if it is not 
there but the Log Item remains visible in the Log and can be restored if need 
be.
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If a Log Item is Permanently Deleted then it is removed from the Schedule 
Log all together and the only way of putting it back in to the Log is to manually 
insert it again.

This is not so important when using the right click menu in Remote Voice 
Tracking as you can not Delete Permanently using Remote Voice Tracking.

The right click Delete menu option allows you to Soft and Permanently delete 
Log Items depending on which one suits your needs best.

 Soft Delete – Selecting this option will soft delete the Log Item that you 
right clicked on.

 Restore – This option is only available when you right click on a Log 
Item that has been Soft Deleted and selecting it will restore it back to 
the Schedule Log.
Delete Permanently – This option is not available in Remote Voice 
Tracking.

There are also a couple of other options when it comes to Soft Deleting Log 
Items.

You can also Soft Delete Log Items by clicking on the Log Item Type icon to 
the left of the Log Item.

You can also Restore a Soft Deleted Log Item by clicking on the Log Item 
Type icon.

Advanced Log Item Options
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The Advanced right click menu option is only available on certain Log Items 
depending on how you have configured Myriad. It is used to view and edit 
whether a particular Log Item can be dropped automatically or faded our 
earlier when Myriad is running in AutoFade Playout Mode. For this reason, the 
Advanced option is only available on Log Item Types that are allowed to be 
dropped or faded in AutoFade mode so it would normally be available when 
right clicking on Songs but not when you right click on an Advert.

The reason for the vagueness is that you can configure Myriad to fade Log 
Items other than Songs early using the Settings Menu > Database Settings 
and Q-AE tab in Myriad.

You can toggle the ‘This Item Can Be Dropped’ and ‘This Item Can Be Faded’ 
options on and off by clicking on them. This will add or remove a tick from the 
menu option to indicate the status of the Log Item you originally right clicked 
on. 

In the example below, the Log Item can be faded early in AutoFade mode but 
can not be dropped.
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N.B. If an item can not be dropped by Myriad in AutoFade Playout Mode, the 
timing information to the right of the Log Item is displayed in red text.

Locked

The Locked option on the right click menu is used to indicate whether a Log 
Item is Locked and also to manually toggle a Log Item status between Locked 
and normal status.
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If the Locked menu option has a tick by it, then the Log Item that you right 
clicked on is Locked. This will also be indicated by a padlock icon on the Log 
Item Type indicator.

If an item is Locked then it can not be moved within the Schedule Log or 
deleted from the Schedule Log. Myriad normally locks Log Items a few 
seconds before it plays them but you can manually lock a Log Item by clicking 
on the Locked right click menu option. 

Preview Log Item’s Hook

The Preview Hook option on the right click menu allows you to cue just the 
Hook from the Log Item you right clicked on with the Cart Player in Preview 
mode.

Remote Voice Tracking will first check the audio file cache to see if the Cart 
has already been downloaded. If it has then it will use the downloaded version 
of the Cart and play you the ‘Hook’ using a free Cart Player. If the Cart is not 
present in the audio file cache then Remote Voice Tracking will download it 
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from the Remote Edit Server and play the Hook once the download is 
completed. 

Preview Log Item

The Preview option on the right click menu will cue the selected Log Item in to 
a Cart Player in Preview mode.

Remote Voice Tracking will first check the audio file cache to see if the Cart 
has already been downloaded. If it has then it will use the downloaded version 
of the Cart to play using a free Cart Player. If the Cart is not present in the 
audio file cache then Remote Voice Tracking will download it from the Remote 
Edit Server and play Cart once the download is completed. 

The Hour Start Marker Right Click Menu

The Hour Start Marker has its own right click menu with different options to 
the standard right click menu for Log Items.

Change Hour Mode

You can use the Change Hour Mode right click option to change the 
scheduled Active Playout Mode for an hour in the Schedule Log. 
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Use the right click menu to select the mode that you wish to change to, the 
currently selected mode is indicated with a tick, click on another mode to 
change it.

The options are:

 Live – Presenter controls the segues.
 Auto – Myriad automatically segues each item.
 AutoFade – Myriad automatically segues each item and back-times to 

Time Critical Events (Absolute Time Markers).

Once you have changed the Active Playout Mode, Myriad will automatically 
switch to that mode when the Hour Start Marker is reached.

CAUTION – Remember that Myriad deals with the Schedule Log an hour at a 
time so if you have three hours that were originally scheduled as Live Playout 
Mode and you want to switch the to play in AutoFade mode, you will need to 
right click each of the three Hour Start Markers and make the change, 
otherwise, the first hour will be ok but at the start of the second hour, Myriad 
would switch back to the original Live playout mode which could be a disaster 
if it was at 3am on New Years day!

Soft Delete All The Items In This Hour

If you select this option then Myriad will soft delete all the items in the hour 
you are working with leaving it effectively empty. 
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This option can be very useful if you have a breaking story or event that 
means that you need to ditch the originally scheduled programming and use 
some alternative. 

Restore All Items In This Hour

The Restore All Items option does the opposite to the delete all items in that it 
goes through the current hour and restores any Log Items that have been soft 
deleted. 

Obviously this is useful for reversing the Soft Delete All option but it can also 
be useful if you have Soft Deleted a number of Log Items in the hour but you 
want to restore them all and start again. Instead of having to go through the 
hour manually restoring them, you can do them all in one go with this option.

Update Timing Information For This Hour

Update Timing Information For This Hour is used to force Remote Voice 
Tracking to recalculate the Estimated Play Times for each Log Item in the 
hour. The Estimated Play Times are calculated when the schedule is first 
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imported in to Myriad but then they are not checked again until the hour is 
played in one of the Active Playout modes. 

Print Hour

The Print Hour option will send a text version of the hour of the Schedule Log 
you are working on, to your default printer. Once the print is complete, you will 
get a conformation message.

Page Up / Page Down

The Page Up / Page Down buttons are used to scroll up or down the 
Scheduled Log a page at a time. Unlike Myriad which scrolls through the Log 
a line at a time, Remote Voice Tracking deals with the Schedule Log a page 
at a time (to make remote work more efficient) which means that if you use 
the <Cursor Keys> (or mouse wheel) to move up and down in the Scheduled 
Log, Remote Voice Tracking will only move on to the next page of Scheduled 
Log when you scroll off the bottom of the currently visible Log. The Page Up / 
Down button on screen will move up or down by a page at a time regardless 
of where the highlighted Log Item is.

Home

The Home button on Remote Voice Tracking will take you to the Log Item that 
is scheduled to be played closest to current time. So if it is 2pm on Tuesday, 
hitting home will jump to the Log Item that is scheduled to be playing at 2pm 
on Tuesday.

The Segue Edit Panel

The Segue Edit Panel is used to show a visual representation of the way in 
which Myriad will perform the transition or ‘segue’ between the two highlighted 
Log Items.

The Segue Edit Panel can actually be viewed in two mode, Mini Segue Editor 
Mode.
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And Full Segue Editor Mode (accessed by clicking on the SegEdit button on 
the left hand side of the screen).

Mini Segue Editor mode is used to review and edit the way in which Myriad 
will perform segues (or transitions) between Log Items when it is playing them 
in one of the Active Playout Modes. The graphics represent the Carts 
involved, the Extro point on the Cart that is just finishing and the Intro Start / 
End of the Cart that will play next. By dragging lower item(s) to the left or right, 
you can adjust the way that Myriad will ‘mix’ the two Log Items together in 
automated playout.

Full Segue Editor mode offers the same functions a Mini Mode but also adds 
the ability to add / adjust fade points on the finishing Item(s) so that you have 
full control over how the segue will sound. You also use the Full Mode Segue 
Editor to record Voice Tracks in to the Schedule Log but more on that later.

Both the Mini Segue Editor and the Full Segue Editor are covered in more 
detail later in this section.

Notes

The Notes panel displays any Notes that included as part of the Scheduled 
Log or an Notes associated with a Cart, with reference to the Log Item that is 
currently highlighted. As you scroll up and down the Schedule Log you will 
see the Notes panel update automatically as you highlight a Log Item with 
Notes of some form associated.
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Cart Players

The Cart Players in Remote Voice Tracking operate in the same way as the 
Cart Players in Myriad. As Remote Voice Tracking needs to play Carts, they 
are loaded in to one of the free Cart Players at the bottom of the screen and 
played either manually (by clicking on the Play button on the Cart Player) or 
more often, automatically by Remote Voice Tracking as part of a segue 
preview or Voice Tracking session.

The Record Card Player is also the same as the one found in Myriad and is 
used to record Voice Tracks in to the system ready for uploading to the 
Remote Edit Server.

The Cart Players (playback) consists of four Cart Controls (Play, Pause, 
Recue and Eject) as well as Cart title and timing information. The Record 
Card Player consists of a Record / Stop Recording button and some general 
timing information.

The Cart Players are covered in detail in the main Myriad User Guide and are 
fundamental to understanding Myriad so we will not re-cover old ground here. 
If you do need more information on Cart Players then please refer to the main 
Myriad User Guide for more details.

Preview

The Preview allows you to preview the Log Item that is currently highlighted 
using a Cart Player.

When you Preview a Cart in Remote Voice Tracking, the system will first 
check the local audio file cache to see if the Cart has been downloaded and 
stored previously. If it finds the Cart then it will use the cached copy but if not 
then it will download the a low quality version of the Cart from the Remote Edit 
Server and load it in to a Cart Player once it has finished downloading.
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You can use the Cart Player in the normal way when working with Previews.

SegEdit

The SegEdit button toggles Remote Voice Tracking between displaying the 
Mini Mode Segue Editor. 

And the Full Mode Segue Editor.

The Full Mode Segue Editor is used for recording Voice Tracks in to the 
Scheduled Log so you will need to click on the SegEdit button to start a 
Remote Voice Tracking session.

GoTo

The GoTo button is used to jump to a particular time and date in the Scheule 
Log.

This is especially useful when remotely Voice Tracking as you will normally be 
Voice Tracking a show for delivery some time in the future and this facility 
negates the need to scroll through the Schedule Log looking for the show you 
wish to Voice Track.

To use this feature, click on the GoTo button and select the time and date that 
you wish to work with using the Select Date window.
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When you are happy click on OK.

Remote Voice Tracking will then display the selected hour in the Scheduled 
Log. If the hour is not available in the Scheduled Log (because it has not been 
scheduled yet) then Remote Voice Tracking will tell you so. 

Menu Options

The Menu Options offer a range of tools and options for use with Remote 
Voice Tracking. As with all menu systems, the options are divided in to a 
number of categories to make navigation as easy as possible. Each of Menu 
Options is outlined below.

File Menu > Disconnect From Myriad

This option will close the connection to the Remote Edit Server and return 
Remote Voice Tracking to the Connection Settings window.

File Menu > Open Station Database

This option is only enabled if no Station Database is currently open and it 
allows you to select a Station Database to work with from the list of available 
Station Databases on the Remote Edit Server you are connected to.
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File Menu > Close Station Database

This option is only available if a Station Database is currently open and it is 
used to close the current Station Database that you are working on.

File Menu > Exit

Used to close the connect to the Remote Edit Server and exit from Remote 
Voice Tracking.

Log Options Menu > Display Segue Editor

This option toggles Remote Voice Tracking between the Mini Mode Segue 
Editor and the Full Mode Segue Editor.

Log Options Menu > Print Current Hour

This will print out a list of all the current Log Items in the hour you are working 
with, using your computers default printer.

View Menu > View Audio Browser

This will open the Audio Browser which can be used to browse your Myriad 
Audio Wall and drag Carts directly in to the Schedule Log.
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Whist the Remote Voice Tracking Audio Browser looks and acts like the 
Myriad Audio Browse but with one exception. To the right if each item in the 
Audio Browser is either a tick or a cross.

In Remote Voice Tracking, the tick signifies that the audio file for the Cart has 
been downloaded and is available in the audio file cache. If there is a cross 
then that means that the file has not been downloaded yet or is not available 
in the audio file cache. You can still drag in Carts in to the Log that have not 
been downloaded, they will just need to be downloaded before you can 
preview them.

The rest of the Audio Browser is the same as the Audio Browser in Myriad 
and is covered in detail in the main Myriad User Guide.
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Tools Menu > Clear Client Cache

This option is used to delete all of the files in the audio file cache that Remote 
Voice Tracking has stored on the local PC. You can use this option to free up 
disk space but it will also slow down remote voice tracking as you will need to 
re-download all of the Carts you want to preview.

Tools Menu > Clear Server Cache

This option is only available if the Remote Edit Server has been configured to 
allow clients to clear the Remote Edit Server audio file cache. If you select this 
option then all of the stored ‘low quality previews’ on the Remote Edit Server 
will be deleted and the Remote Edit Server will need to generate new low 
quality previews the next time a Remote Voice Tracking client requests them.

Settings Menu > Audio Settings

The Audio Settings option opens the Audio Settings window which is used to 
override the Remote Edit Server settings for trigger level recording when 
recording Remote Voice Tracks.

At the station, all of the Myriad workstations will be configured to use the 
same ‘trigger level’ threshold when recording voice tracks but as your remote 
equipment may be very different, you may need to override this global Myriad 
setting and set a level that is more appropriate for your station.

For more details, please refer to The Connections Settings Window In 
Advanced Mode > The Local Resources Tab.

Help Menu > Update Information

This option provides access to a special text file that is installed each time you 
update your Remote Voice Tracking installation and it contains important 
information about new features, enhancements and bug fixes for the version 
of Remote Voice Tracking that you are running.
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Help Menu > Contents

Provides access to the Remote Voice Tracking online help system.

Help Menu > Search

Allows you to search the Remote Voice Tracking online help system to track 
down the answer you are looking for.

Help Menu > About

This option opens the About Remote Voice Tracking window which provides 
information about the exact version number of Remote Voice Tracking that 
you are using.
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You may be asked to provide this version number information to a P Squared 
engineer should your require any technical support.

The Mini Segue Editor

The Mini Segue editor appears on the Remote Voice Tracking at all times and 
shows a graphical representation of the segue between the currently 
highlighted Log Item in the Log and the pervious Log Item.

In the example above, ‘The look Of Love’ is highlighted so the Mini Segue 
Editor shows a graphical representation of the segue that it will perform (or did 
perform) between ‘The Look Of Love’ and ‘Like To Get To Know You Well’ 
which is the previous item in the Log. 

The Mini Segue Editor shows the amount of overlap between the Extro point 
of the previous track and the Intro of the currently highlighted track. It also 
allows you to manually move these points to experiment with alternative 
segues and ultimately, save a new segue that Myriad will use when the time 
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comes to play out these two items. But let’s look at the Mini Segue Editor in 
more detail first.

Let’s look at that segue in a little more detail. The diagram above shows the 
segue as Myriad will perform it before we have edited it in any way. You will 
see that the previous item (in yellow) appears as a block with a sloped ending. 
The top of the slope represents the Extro point in the Log Item and the bottom 
of the slope represents the very end of the audio file. This means that the 
slope shows the duration from the Extro point to the end of the audio file.

The next Log Item (in green) is represented in a similar way but in this case, 
the bottom of the slope represents the Intro Start of the audio file and the top 
represents the Intro End point so the slope shows the duration of the Intro on 
the Log Item.

If we have not edited the segue then Myriad will perform the segue at the 
Extro Point as can be seen in the diagram.

Now let’s use the left mouse button to drag ‘The Look Of Love’ to the left or 
right to alter the way Myriad will perform the segue and see what happens.

Here we can see that ‘The Look Of Love’ has been dragged to the left which 
moves the Segue Point to the left as well. This means that in this example, 
‘The look Of Love’ would start playing earlier in to ‘Like To Get To Know You 
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Well’, several seconds before the Extro point on the Song. We can now 
review the edited segue by clicking on the Play segue button.

Remote Voice Tracking will first check the local audio file cache to see if it has 
local copies of the Carts involved, if so it will use them but if not then it will 
request a low quality version of each Cart from the Remote Edit Server.

Once the files it needs are downloaded, Remote Voice Tracking will load them 
in to Cart Players and begin playing a preview of the segue.

While the segue is playing, you can drag the Log Items within the Mini Segue 
Editor until you get the segue exactly the way you want it. Once you are 
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happy, click on the Save Segue button to commit your new segue timing 
details to the Schedule Log via the Remote Edit Server.

The Mini Segue Editor is a very difficult thing to explain but once you see it in 
action, it should all make sense.

Below are a couple of other examples of the Mini Segue Editor in action under 
different circumstances.

In this situation, we are using the Mini Segue Editor to review a Voice Track 
between two Log Items. It works in exactly the same way, there is just three 
Log Items in view at once to allow for the unique characteristics of Voice 
Tracked segues.

In this case, we are looking at a segue between two Log Items that have no 
Extro or Intro’s set. These are both jingles in so it does not matter too much 
but if these were songs then they would require some attention.

If at any point, you want to get a bit more control of the Segue Editing or if you 
want to record a Voice Track in to the segue then you can always click on the 
SegEdit button to switch in to full Segue Editor mode.
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But more on this later (see Segue Editor).

Full Mode Segue Editor (And Voice Tracking)

The SegEdit button on the Main Tab Strip is used to toggle between the Mini
Mode Segue Editor and the Full Mode Segue Editor. Clicking on the SegEdit 
button will have the effect of enlarging the Mini Segue Editor in to full Segue 
Editor mode which allows you to adjust the fade points, position the segue 
between two Log Items and allowing you to record a Voice Track in between 
two Log Items.
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The Large green arrow on the Schedule Log shows the two (or sometimes 
three) Log Items that are currently displayed in the Segue Editor.

You will notice that when you go in to full Segue Editor mode, two or more 
Cart Players will be reserved for use by the Segue Editor.

To review a segue, click on the Play button on the Segue Editor and playback 
will begin using the reserved Cart Players.

You can stop playback at any time by clicking on the Stop button (which 
replaces the Play button while it is playing).
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Adjusting Positioning And Fading In SegEdit Mode

Once you are in Full Segue Edit mode, the Segue Editor works in exactly the 
same way as the Mini Segue Editor (see Mini Segue Editor). The currently 
highlighted Log Item is shown in the lower section of the Segue Editor (in 
green) and the previous Log Item is shown in the top section in yellow. As 
before, the downward slope on the top Log Item indicates the duration 
between the Extro point on the item and the very end of the audio file. The 
upward slope on the lower item represents the duration between the start of 
the Log Item and the Intro End point. The vertical line represents the segue 
point between the two Log Items and as we have not edited the segue yet, it 
will be at the previous Log Item’s Extro point.
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To edit the Segue point between the two items, you the left mouse button to 
drag the lower Log Item to the left or right.

Note how the Segue Point moves with the start of the Lower Log Item. 

CAUTION: when you release the Log Item, the Segue Editor will automatically 
begin playback of your newly edited segue in the Segue Editor reserved Cart 
Players.
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Again, if Remote Voice Tracking can use a low quality version of the audio 
from audio file cache, it will do so. If there is not a low quality version available 
locally then Remote Voice Tracking will download a low quality version of the 
Carts it needs from the Remote Edit Server

Once playback has started you can continue to edit the segue in the same 
way if needed. To stop playback, click on the Stop button.

If you wish to abandon your segue edit and return the segue to its original 
position, click on the abandon button.



116

When you are happy, click on the Save button to save the new segue 
information to the Schedule Log via the Remote Edit Server.

You can also use this mode to edit the way in which the previous Log Item is 
faded out to allow for greater control of the segue. This is done by adjusting 
the fade ‘envelope’ (the blue line) on the upper section of the Segue Editor.

The fade ‘envelope’ consists of two editable points, one for the start of the 
fade and the other for the end. In the example above, the fade start and end 
are directly above each other and at the end of the audio file so effectively, 
Myriad will not fade the item at all. In the example below, the fade ‘envelope’ 
has been adjusted to start fading the item out earlier.
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Note how the fade ‘envelope’ has been edited to start fading before the song 
reaches its Extro point and will be faded out completely before the end of the 
audio file is reached.

To edit the fade ‘envelope’ use the left mouse button to drag the fade start 
and end points to the left or right.

Again, you can use the Save button to save your edited fade ‘envelope’ and 
the Abandon button to discard your fade ‘envelope’ changes and return to the 
original state.

Recording A Remote Voice Track

The other primary use for the Segue Editor in full mode is to allow you to 
record Voice Tracks between Log Items to be played back by Myriad in one of 
the Active Playout modes.

In general Voice Tracking (as it is known) is used to add ‘live’ sounding voice 
links to automated playout to make the listener think that a presenter is 
presenting the show when in fact Myriad is playing a mixture of Log Items and 
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pre-recorded voice links. The key thing is that when Voice Tracking, each 
voice link is recorded as if it were being done ‘live’ and specific for the Log 
Items that it is positioned between. Myriad then plays the Voice Tracks exactly 
as they were recorded meaning that they should be indistinguishable from the 
‘real thing’.

In practice, the Voice Tracking process is very simple to allow the present to 
concentrate on the content of their links and not what buttons they are 
pressing. In general, the entire process can be controlled by one button and 
each stage happens automatically. Remote Voice Tracking allows the Voice 
Tracking process to be done from a remote location, the procedure is the 
same but instead of playing the Carts from and recording the Voice Track to 
the Myriad server, the Remote Voice Tracking application will download low 
quality versions of the Carts to use for playback and record a local high quality 
Voice Track which will be uploaded to the Remote Edit Server at the end of 
the Voice Tracking process.

The general process is:

1. Click on the SegEdit button to open the Segue Editor in full mode.
2. Highlight the Log Item that you want to be playing at the end of your 

Voice Track. You can use the GoTo button on the Main Tab Strip to 
jump to a specific time and date in the Schedule Log if you need to.

3. Press one of the following to start the Voice Tracking process:

 Click on the Voice Tracking button on screen .
 Press the <Space Bar> (make sure that the Log Screen was the 

last screen you clicked on as you do not want to accidentally 
trigger an Audio Wall play).

 Press the <Ctrl>+<Space Bar> (this method works whichever 
screen you clicked on last).

 Press the Segue Step button on your Myriad keyboard.

4. Whichever method you chose, the result will be the same, Remote 
Voice Tracking will first check the local audio file cache to see whether 
there is a low quality ‘preview’ version of the Carts that it will need in 
order to play the last few seconds of the previous track and the first few 
seconds of the next. If the audio file cache already contains the Carts 
that Remote Voice Tracking needs then it will load them in to the Cart 
Players and the last few seconds of the previous Cart will automatically 
begin playback. If Remote Voice Tracking can not find low quality 
‘previews’ of the Carts in question then it will request the Carts from the 
Remote Edit Server which will generate the low quality versions of the 
Carts and download them to Remote Voice Tracking. Once Remote 
Voice Tracking has finished downloading them, it will load them in the 
Cart Players and the last few seconds of the previous Cart will start 
playing automatically.
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5. When you are ready to record your link, put the ‘mic’ fader up and start 
speaking. Myriad will automatically detect the incoming audio level and 
start recording in to a local audio file that will be uploaded to the 
Remote Edit Server once you have finished the Voice Track. If you 
have not configured Myriad to start from a ‘trigger’ audio level or you 

wish to start recording manually, click on the Record button 
(which takes the place of the Voice Tracking button) or press either one 
of the <Space Bar> or <Ctrl>+<Space Bar> button options to manually 
start recording.
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6. When you are ready to start the next Log Item playing, click on the Play 

Next button  or press the <Space Bar> or <Ctrl>+<Space Bar> 
keyboard options (or the Segue Step button on your Myriad keyboard).
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7. When you have finished your Voice Track, click on the Stop button 

 or press the <Space Bar> or <Ctrl>+<Space Bar> options (or the 
Step Segue button).

8. You will then be asked to confirm whether you wish to save the 
recorded audio (and the Voice Track information) or whether you wish 
to discard it. Click on Yes to keep the Voice Track or No to discard it.

Note that at this stage, Remote Voice Tracking has assigned a Cart 
Number for your Voice Track, once your Voice Track has been 
uploaded, Remote Edit Server will automatically place the recorded 
voice in to the assigned Cart Number. Should that Cart Number not be 
available for any reason, Remote Edit Server will automatically assign 
the Voice Track to another Cart Number in the same Voice Tracking 
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range (as defined in the Station Database) and update the Schedule 
Log accordingly so the Voice Track plays out correctly).

9. Remote Voice Tracking will then compress the Voice Track (if the 
Remote Edit Server has been configured such that Voice Tracks are 
compressed) and then upload both the Voice Track and the additional 
timing information for the positioning of the Voice Track, to the Remote 
Edit Server which in turn will update the stations Myriad system.

10.That is it, you finished Voice Link has been uploaded to the station’s 
Audio Wall and the relevant details have been added to the Schedule 
Log.
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Note how the large green arrow on the Schedule Log shows the Log 
Items that are displayed in the Segue Editor.

This may seem a little complicated in the above example but that is because 
there are a number of different methods that you can use to step through the 
Remote Voice Tracking process. Let’s look at the process again but this time 
we will just assume that we will just use the <SPACE BAR> to step through 
each part of the process.

Here we go!

Firstly, click on the SegEdit button to open the Full Segue Editor.
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Ensure that the highlight is on the Log Item that you want to playing when you 
finish you link.

Now press the <Space Bar>
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First, Remote Voice Tracking will check to see if there is a local copy of the 
Carts it needs to use (in this case Don’t Stop Moving and AM to PM) in the 
local audio file cache. If low quality ‘preview’ versions of the Carts are present 
in the file cache then Remote Voice Tracking will use them, if not then it will 
download a low quality version of each Cart from Remote Edit Server.

Once it has downloaded (or loaded local copies of) the Carts it needs, 
Remote Voice Tracking will load the Carts in to the Cart Players and the end 
few seconds of ‘Don’t Stop Moving’ start playing in one of the reserved Cart 
Players. 

Let’s assume that we have configured Remote Voice Tracking to record from 
a ‘trigger’ audio level when working with the Segue Editor. In this 
configuration, Remote Voice Tracking will automatically start recording as 
soon as the incoming audio level exceeds the defined ‘trigger’ level. The 
audio will be saved in to a local audio file and then uploaded to the Remote 
Edit Server when the recording is complete. It will display the end Cart on the 
Audio Wall that it intends to use on the Myriad system once it is uploaded but 
this is not ‘written in stone’ yet as when the file is uploaded to Remote Edit 
Server, it will check that the Cart is still available. If not then it will use another 
Cart and then update the log accordingly.

So to start recording our voice link, we put the ‘mic’ channel fader up (on our 
mixing desk) and start speaking.
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Next we want to start the next Log Item playing. Once again, hit the <Space 
Bar> to start playback.

Only one more step to go! Currently, Remote Voice Tracking is still recording 
our voice and the next Log Item has been started. We can use the Cart 
Players to talk right up to the Intro End on the Song if we like but either way, 
as soon as we don’t want to speak any more, press the <Space Bar> to halt 
playback and ask whether you wish to keep or discard the Voice Track.

You can click on the Yes button to keep the Voice Link or the No button to 
discard it but as a tip, because the Yes button has focus, you can also press 
the <Space Bar> to keep the link.
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If you select Yes then Remote Voice Tracking will compress the Cart (if 
Remote Edit Server has told it that it should) and then upload the recorded 
Voice Track to the Remote Edit Server along with all of the Schedule Log 
timing information.

As you can see, the Voice Track has been added to the Schedule Log and the 
details are displayed in the Segue Editor. 
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You can review the Voice Link by clicking on the Play button . The Link 
will be played in reserved Cart Players.
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If we leave this link as it is, Myriad will play it back exactly the way we 
recorded it in Active Playout mode so if we had been singing along to the 
vocals, that is what will go out ‘on air’. Myriad will even automatically ‘duck’ 
the volume of the two songs whilst the Voice Track is playing to allow the 
voice to ‘travel’ over the songs.

Alternatively, we can use the Segue Editing and fade ‘envelope’ editing 
techniques we discussed earlier to move any of the Log Items involved with 
our Voice Link around and change the fade points on the previous Log Item 
and Voice Link.
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Using these techniques, you can tidy up any gaps in your voice link, fade out 
the previous song early and generally make it a s tight sounding as you like. 
When you have finished, click on the Save button to commit your changes to 
the Schedule Log, Remote Voice Tracking will then upload these changes to 
the Remote Edit Server which will update Myriad accordingly.

Trouble Shooting 

In this section we will cover some of the more common problems you may 
encounter.

Login Authentication Failed – You Don’t Have The Correct Rights 
To Access The Myriad System

If you login to Remote Voice Tracking using a valid Myriad Username and 
Password but Remote Voice Tracking does not let you in and puts up the 
above message instead then that means that your have a valid Myriad 
Username but you do not have sufficient access rights to access Myriad 
remotely using Remote Voice Tracking. 

To fix this problem, at the station, run Myriad Manager and then click on the 
Contact / Users tab. Next find, the your Username and double click on it to 
view your User Details. Click on the Settings tab and make sure that the ‘Use 
The Following Security Permissions Instead’ option is ticked and then  click on 
the Edit Permissions button (the one with a spanner on it).
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Finally, click on the Myriad v3 options (on the left hand side) on the Contact’s 
Permissions window and tick the ‘Can Remotely Edit The Schedule Log’ 
option.

Remote Voice Tracking Is Playing Or Recording Using The Wrong 
Sound Device

Unlike Myriad which allows you to specify what sound device to use for 
playback and recording, Remote Voice Tracking uses the default Windows 
sound devices for playback and recording.

The problem is that you may have more that one sound enabled device 
attached to your PC (especially if you have things like USB modems 
connected).

In order to alter the default Windows sound devices, click on the Start button 
and select Control Panel. Control Panel can be viewed in two different ways in 
Windows XP depending on how you have set up your PC.
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Category View

Classic View
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If you are in Category View, click on ‘Sounds, Speech, & Audio Devices’ 
option, then the Sound & Audio Devices option which will open the Sound and 
Audio Devices Properties window.

If you are in classic view, double click on the Sounds and Audio Devices 
Option.

In both cases, the Sound and Audio Devices Properties window will open.

Switch to the Audio tab and then use the drop down list to select the Sound 
Playback and Sound Recording Default Devices.

The Connection To The Remote Edit Server Failed – Connection Is 
Forcefully Rejected

If you get the message below when you attempt to connect a Remote Edit 
Server then is means one of two things.
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1. The Remote Edit Server Is Not Running At The Station – The first 
thing to check is that Remote Edit Server is running on the appropriate 
PC at the radio station. 

2. The Firewall (at either end) Is Blocking The Ports Remote Edit 
Server / Remote Voice Tracking Are Using To Communicate – The 
other reason for seeing this error on connection is if the firewall at 
either end is blocking the Data and Communication Ports that Remote 
Edit Server and Remote Voice Tracking are using to communicate. 
You need to ensure that both firewalls are configured correctly in order 
for this to work. Please refer to your firewall’s documentation for more 
details as P Squared are not able to provide any technical assistance 
with the configuration of firewalls and other third party networking 
devices.
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